
I 2 C

VBATT

DRV

3.3 V

CC1310
(ARM + Sub-1 GHz)

Coin Cell Battery
(CR2032)

HDC1010
(Humidity and Temp.)

TPS22860
(Ultra-low leakage 

load switch)

VOUT
(3.3 V or
VBATT)

TPL5111
(Nano-power system 

timer)

TPS61291
(DC-DC Boost)

Copyright © 2016, Texas Instruments Incorporated

1TIDU995E–June 2015–Revised September 2018
Submit Documentation Feedback

Copyright © 2015–2018, Texas Instruments Incorporated

Humidity and Temperature Sensor Node for Sub-1GHz Star Networks
Enabling 10+ Year Coin Cell Battery Life

TI Designs: TIDA-00484
Humidity and Temperature Sensor Node for Sub-1GHz
Star Networks Enabling 10+ Year Coin Cell Battery Life

Design Overview
This TI Design uses Texas Instruments' nano-power
system timer, boost converter, SimpleLink™ ultra-low
power sub-1 GHz wireless microcontroller (MCU)
platform, and humidity sensing technologies to
demonstrate an ultra-low power method to duty-cycle
sensor end-nodes, leading to extremely long battery
life.

Design Resources

TIDA-00484 Tool Folder Containing Design Files
HDC1010 Product Folder
HDC1080 Product Folder
CC1310 Product Folder
TPL5111 Product Folder
TPS61291 Product Folder
TPS22860 Product Folder
TPD1E10B06 Product Folder

ASK Our E2E Experts
WEBENCH® Calculator Tools

Design Features
• Use of Nano-Power System Timer to Duty-Cycle

the System Results in 10+ Year Battery Life from
CR2032 Coin Cell

• Configurable System Wakeup Interval
• Extremely Low Off-State Current (270 nA for 59.97

Seconds)
• Ultra-Low On-State Current Due to Low Active

Processor and Radio Transmit Currents (3.376 mA
for 30 ms)

• ±3% Relative Humidity Accuracy
• ±0.2°C Temperature Accuracy

Featured Applications
• Industrial
• Internet of Things (IoT)
• Building Automation
• Intrusion Detection
• HVAC Sensors
• Smart Thermostats and Room Monitors
• Battery Powered Systems

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other
important disclaimers and information.

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU995E
http://www.ti.com/tool/TIDA-00484
http://www.ti.com/product/HDC1010
http://www.ti.com/product/HDC1080
http://www.ti.com/product/CC1310
http://www.ti.com/product/TPL5111
http://www.ti.com/product/TPS61291
http://www.ti.com/product/TPS22860
http://www.ti.com/product/TPD1E10B06
http://e2e.ti.com
http://e2e.ti.com/
http://e2e.ti.com/support/development_tools/webench_design_center/default.aspx
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1 Key System Specifications

PARAMETER SPECIFICATIONS DETAILS
Input power source CR2032 Lithium-ion coin cell battery (3.0-V nominal voltage) Section 2.6
Sensor type Humidity and temperature Section 2.1
Measurement interval One measurement per minute Section 2
Average on-state current
consumption 3.376 mA Section 6.2.1

On-state duration 30.0 milliseconds Section 6.2.1
Average off-state current
consumption 269.75 nA Section 6.2.2

Off-state duration 59.97 seconds Section 6.2.2
Estimated battery life 11.90 years Section 6.2.3
Operating temperature –30°C to 60°C (limited by CR2032 coin cell operating range) Section 2.6
Working environment Indoor and outdoor Section 2.6
Form factor 1.5 inch × 3.0 inch rectangular PCB Section 5.1

http://www.ti.com
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2 System Description
Many industrial, building automation, and IoT systems require increasing numbers of wireless sensor end-
nodes. However, one of the major constraints of adding many wireless sensor end-nodes to a system is
power. Typical sensor end-nodes are powered by batteries, which last from several months to several
years depending on the power consumption of the end node. Replacing batteries can be a very expensive
system-level cost, because each end node requires a periodic manual battery replacement.

Enabled by Texas Instruments’ nano-power system timer, DC-DC boost converter, SimpleLink™ ultra-low
power wireless microcontroller (MCU) platform, and humidity sensing technologies, the Humidity and
Temperature Sensor Node for Sub-1GHz Star Networks Enabling 10+ Year Coin Cell Battery Life TI
Design demonstrates an ultra-low power method to duty-cycle sensor end-nodes leading to extremely long
battery life.

At a high level, this TI Design system consists of a CR2032 coin cell battery, a nano-power system timer,
a low IQ boost converter, an ultra-low power wireless MCU, and a combined humidity and temperature
sensor. The nano-power system timer, which consumes tens of nanoamps when operating, controls
power to all the remaining circuitry. The nano-power system timer switches on power to the system and
enables the boost converter at a programmable interval (one measurement per minute in this system);
when the wireless MCU has finished reading and transmitting the sensor data, a signal to the system timer
shuts down the entire system and puts the boost converter in bypass mode. By duty-cycling the entire
system in this manner, this TI Design achieves more than ten years of battery life from a CR2032 coin
cell.

This design guide addresses component selection, design theory, and test results of the TI Design
system. The scope of this design guide gives system designers a head-start in integrating TI’s nano-power
system timer, boost converter, SimpleLink ultra-low power wireless microcontroller (MCU) platform, and
humidity sensing technologies into their end-equipment systems.

The following sub-sections describe the various blocks within the TI Design system and what
characteristics are most critical to best implement the corresponding function.

2.1 Humidity and Temperature Sensor
In this TI Design, a digital humidity sensor with an integrated temperature sensor was chosen to
demonstrate the ultra-low power, duty-cycling power scheme. Humidity and temperature are both common
measurements required for many end-equipment systems in industrial and building automation
applications. For example, home heating and cooling systems of the future are likely to include humidity
and temperature measurements in each individual room. With the wireless functionality of the system, this
environmental information is sent back to a smart thermostat, which then controls the various air ducts
connecting to each room, providing a much more intelligent home environment by providing individual
comfort settings and increasing energy savings.

With a relative humidity accuracy of ±2% and a temperature accuracy of ±0.2°C, the HDC1010 device
from Texas Instruments is ideally suited to accurately sense environmental information. The innovative
placement of the HDC1010 sensing element on the bottom of the device provides resistance to dust, dirt,
and other environmental contaminants, which improves system reliability for applications like heating,
ventilation, and air conditioning (HVAC) systems, smart thermostats, and room monitors. Furthermore, the
power consumption of the HDC1010 is extremely low, averaging 1.2 μA at a one sample per second
measurement rate. Interfacing to the device is straightforward with any microcontroller platform using the
I2C communication protocol.

This TI Design also includes provisions for installing the HDC1080, which has the same performance
specifications as the HDC1010 device, but comes in an industrial-friendly WSON package. Any further
reference to the HDC1010 device in this document can be construed to be either HDC1010 or HDC1080.
Only one of the HDC devices is intended to be populated at a time.

http://www.ti.com
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2.2 Ultra-Low Power Wireless Microcontroller (MCU)
In this TI Design, transmitting the sensor information to some central location for processing is necessary.
However, because power consumption is always a concern in battery-based applications, the radio and
processor must be low power. Also, the wireless protocol required for the end-equipment system is an
important consideration for the selection of the radio device.

With TI’s SimpleLink™ ultra-low power wireless microcontroller (MCU) platform, low power with a
combined radio and microcontroller enables extremely long battery life for sensor end-nodes. Furthermore,
the CC1310 device is a multi-standard device, with software stack support for wM-Bus and TI’s
SimpliciTI™ (star network) network protocol. In this TI Design, a generic proprietary protocol is the
protocol of choice, but the hardware as built can work with other protocols as well.

2.3 Nano-Power System Timer
This TI Design is able to achieve extremely long battery life by means of a nano-power system timer. The
use of this type of device replaces the internal timer of any standard microcontroller with a discrete analog
system timer that consumes much less power than the microcontroller’s internal timer. A nano-power
system timer can be used either to bring an MCU out of sleep mode by means of a pin interrupt, or to
completely shut off power to the system, in whole, or in part.

In this TI Design, the TPL5111 device was chosen to control both the boost converter mode and load
switch, which reduces the off-state current drawn from the battery to the tens and hundreds of nanoamps.
The timer interval is user-selectable by means of a resistor and can range from 100 ms up to two hours,
with a typical time base accuracy of 1%. The TPL5111 device controls the operating mode of a boost
converter, as the following Section 2.4 describes, and a low leakage load switch, as Section 2.5 describes.

2.4 Boost Converter
Some sensor end-nodes require a regulated voltage rail to operate at their highest levels of sensing
performance. To provide a well-regulated voltage rail over the entire lifetime of the battery, a boost
converter is necessary. However, to reduce the battery life loss due to converter inefficiency, an extremely
high-efficiency boost converter is required.

In this TI Design, the TPS61291 device was chosen to regulate the battery voltage to 3.3 V. With a battery
voltage of 3.0 V, the TPS61291 maintains an efficiency level greater than 95% at the load currents typical
of a sensor end-node: 1 mA to 100 mA. Even at the depleted coin cell voltage of 2.0 V, the TPS61291
device maintains an efficiency level greater than 90% over the typical load current range of 1 mA to
100 mA.

Furthermore, the TPS61291 device has a bypass mode that connects the input voltage source directly to
the output pin, while bypassing the boost inductor. This low-loss bypass mode only consumes 15 nA
(typical), which when combined with a low-leakage load switch, enables ultra-low off-state currents.

2.5 Low-Leakage Load Switch
In conjunction with a nano-power system timer (see Section 2.3), this TI Design uses a low-leakage load
switch to shut off power to the wireless MCU and humidity sensor. The most important characteristic of
this switch is the off-state leakage, because that leakage significantly affects the overall battery life of the
system.

In this TI Design, the TPS22860 device was chosen as the switch used to disconnect the system from the
battery. The TPS22860 has a rated leakage current of ±20 nA at 25°C, which enables extremely long
battery life in this system.

http://www.ti.com
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2.6 Coin Cell Battery
The power source for this TI Design is a CR2032 lithium-ion coin cell. The selection of the CR2032 coin
cell battery as the power source was due to the ubiquity of that battery type, particularly in small form
factor systems, such as a sensor end-node.

The voltage characteristics of a lithium-ion CR2032 coin cell battery are also ideal. The output voltage
remains relatively flat throughout the discharge life, until the cell is nearly depleted. When the remaining
charge in the coin cell battery is nearly depleted, the output voltage drops off relatively quickly.

The temperature characteristics of lithium-ion batteries are also superior to that of alkaline cells,
particularly at lower temperatures. This superiority is due to lithium-ion cells having a non-aqueous
electrolyte that performs better than aqueous electrolytes commonly found in alkaline batteries.

However, the CR2032 coin cell battery is still the limiting component in terms of the operating temperature
range; all of the integrated circuits and other electrical components are specified to operate at a wider
temperature range than the battery. Therefore, the specified operating temperature range of the TI Design
system is −30°C to 60°C. Given an appropriate weather-proof enclosure, this TI Design system is suited
for both indoor and outdoor use.

Immediately following the battery is a low forward voltage Schottky diode and a bulk capacitor. The
Schottky diode prevents damage to the hardware if the coin cell battery is inserted backwards. This TI
Design also uses a coin cell battery tray that prevents an end-user from inserting the battery backwards,
which may eliminate the need for the Schottky diode. The bulk capacitor is sized to prevent too much
voltage sag, particularly during the initial transition into the on-state.

http://www.ti.com
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3 Block Diagram

Figure 1. Humidity and Temperature Sensor Node for Sub-1GHz Star Networks Enabling 10+ Year Coin
Cell Battery Life System Block Diagram

3.1 Highlighted Products
The Humidity and Temperature Sensor Node for Sub-1GHz Star Networks Enabling 10+ Year Coin Cell
Battery Life Reference Design features the following devices:
• HDC1010: Low power, high accuracy, digital humidity sensor with

integrated temperature sensor (Section 3.1.1)
• HDC1080:Low power, high accuracy, digital humidity sensor with

integrated temperature sensor (Section 3.1.2)
• CC1310: SimpleLink™ sub-1 GHz ultra-low power wireless MCU (Section 3.1.3)
• TPL5111: Ultra–low power timer with MOS driver and MOSFET power ON (Section 3.1.4)
• TPS61291:Low IQ boost converter with bypass operation (Section 3.1.5)
• TPS22860: Ultra-low leakage load switch (Section 3.1.6)
• TPD1E10B06: Single-channel electro-static discharge (ESD) in a 0402 package with 10-pF

capacitance and 6-V breakdown (Section 3.1.7)

For more information on each of these devices, see the respective product folders at www.ti.com.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU995E
http://www.ti.com
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3.1.1 HDC1010
Features
• Relative humidity accuracy ±2% (typical)
• Temperature accuracy ±0.2°C (typical)
• Excellent stability at high humidity
• 14-bit measurement resolution
• 100-nA sleep mode current
• Average supply current:

– 710 nA at 1 sps, 11-bit RH measurement
– 1.3 µA at 1 sps, 11-bit RH and temperature measurement

• Supply voltage 2.7 to 5.5 V
• Tiny 2-mm×1.6-mm device footprint
• I2C interface

Figure 2. HDC1010 Functional Block Diagram

Description
The HDC1010 is a digital humidity sensor with integrated temperature sensor that provides excellent
measurement accuracy at very low power. The HDC1010 operates over a wide supply range, and is a low
cost, low power alternative to competitive solutions in a wide range of common applications. The
innovative Wafer Level Chip Scale Package (WLCSP) simplifies board design with the use of an ultra-
compact package. The sensing element of the HDC1010 is placed on the bottom part of the device, which
makes the HDC1010 more robust against dirt, dust, and other environmental contaminants. The humidity
and temperature sensors are factory calibrated and the calibration data is stored in the on-chip non-
volatile memory.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU995E
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3.1.2 HDC1080
Features
• Relative humidity accuracy ±2% (typical)
• Temperature accuracy ±0.2°C (typical)
• Excellent stability at high humidity
• 14-bit measurement resolution
• 100-nA sleep mode current
• Average supply current:

– 710 nA at 1 sps, 11-bit RH measurement
– 1.3 µA at 1 sps, 11-bit RH and temperature measurement

• Supply voltage 2.7 to 5.5 V
• Small 3-mm×3-mm device footprint
• I2C interface

Figure 3. HDC1080 Functional Block Diagram

Description
The HDC1080 is a digital humidity sensor with integrated temperature sensor that provides excellent
measurement accuracy at very low power. The HDC1080 operates over a wide supply range, and is a low
cost, low power alternative to competitive solutions in a wide range of common applications. The humidity
and temperature sensors are factory calibrated.

http://www.ti.com
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3.1.3 CC1310
Features
• Microcontroller

– Powerful ARM® Cortex®-M3
– EEMBC CoreMark Score: 142
– Up to 48-MHz Clock Speed
– 128KB of In-System Programmable

Flash
– 8-KB SRAM for Cache
– Up to 20-KB of Ultra-Low Leakage

SRAM
– 2-Pin cJTAG and JTAG Debugging
– Supports Over-the-Air Upgrade (OTA)

• Ultra-Low Power Sensor Controller
– 16-Bit Architecture
– 2KB of Ultra-Low Leakage SRAM for

Code and Data
• Efficient Code Size Architecture, Placing

Peripheral Drivers, RTOS, RF Drivers, and
Bootloader in ROM

• RoHS-Compliant Packages
– 4-mm × 4-mm RSM QFN32 (10 GPIOs)
– 5-mm × 5-mm RHB QFN32 (15 GPIOs)
– 7-mm × 7-mm RGZ QFN48 (30 GPIOs)

• Peripherals
– All Digital Peripheral Pins Can Be Routed

to Any GPIO
– 4 General-Purpose Timer Modules (8 ×

16 Bit or 4 × 32 Bit Timer, PWM Each)
– 12-Bit ADC, 200-ksamples/s, 8-Channel

Analog MUX
– Continuous Comparator
– Ultra-low Power Analog Comparator
– Programmable Current Source
– UART
– 2 × SSI (SPI, µW, TI)
– I2C
– I2S
– Real-Time Clock (RTC)
– AES-128 Security Module
– True Random Number Generator

(TRNG)
– Support for Eight Capacitive Sensing

Buttons
– Integrated Temperature Sensor

• External System
– World’s Smallest Sub-1 GHz Wireless

MCU:
4-mm x 4-mm

– On-Chip Internal DC-DC Converter
– Very Few External Components
– Seamless Integration With the

SimpleLink CC1190 Range Extender
– Pin Compatible With the SimpleLink

CC26xx
• Low Power

– Wide Supply Voltage Range
• Normal Operation: 1.8 V to 3.8 V
• External Regulator Mode: 1.65 V to

1.95 V
– Active-Mode RX: 5.5 mA
– Active-Mode TX at +10 dBm: 12 mA,

+14 dBm: 25 mA
– Active-Mode MCU: 61 µA/MHz
– Active-Mode MCU: 48.5 CoreMark/mA
– Active-Mode Sensor Controller: 8.2

µA/MHz
– Standby: 0.7 µA (RTC Running and

RAM/CPU Retention)
– Shutdown: 100 nA (Wakeup on External

Events)
• RF Section

– Excellent Receiver Sensitivity:
• –121 dBm at 2.4 kbit/s
• –111 dBm at 50 kbit/s

– Very Good Selectivity and Blocking
Performance

– Data Rate up to 4 Mbit/s
– Modulation Support: MSK, FSK, GFSK,

OOK, ASK, 4GFSK, CPM (Shaped-8
FSK)

– Highly Flexible RF Modem (Software-
Defined Radio) to Also Cover Legacy
and Proprietary Communication
Protocols

– Programmable Output Power up to +15
dBm With Shared RX and TX RF Pins
(Regulated Power Supply)

– Antenna Diversity
– Coding Gain

http://www.ti.com
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• RF Section (continued)
– Suitable for Systems Targeting

Compliance With Worldwide Radio
Frequency Regulations

– ETSI EN 300 220, EN 303 131, EN 303
204 (Europe)

– FCC CFR47 Part 15 (US)
– ARIB STD-T108 (Japan)

• Tools and Development Environment
– Full-Feature and Low-Cost Development

Kits
– Multiple Reference Designs for Different

RF Configurations
– Packet Sniffer PC Software
– Sensor Controller Studio
– SmartRF™ Studio
– SmartRF Flash Programmer 2
– IAR Embedded Workbench® for ARM
– Code Composer Studio™

Figure 4. CC1310 Functional Block Diagram

Description
The CC1310 device is the first part in a Sub-1 GHz family of cost-effective, ultra-low power wireless
MCUs. The CC1310 device combines a flexible, very-low power RF transceiver with a powerful 48-MHz
Cortex-M3 microcontroller in a platform supporting multiple physical layers and RF standards. A dedicated
Cortex®-M0 MCU is handling low-level RF protocol commands that are stored in ROM or RAM, thus
ensuring ultra-low power and flexibility. The low-power consumption of the CC1310 device does not come
at the expense of RF performance; the CC1310 device has excellent sensitivity and robustness (selectivity
and blocking) performance. The CC1310 device is a highly integrated solution offering a complete RF
system solution, which includes an on-chip DC-DC converter into a true single-chip solution down to a
4-mm × 4-mm package.

Sensors can be handled in a very low power manner by a dedicated autonomous ultra-low power MCU
that can be configured to handle analog and digital sensors; thus, the main MCU (Cortex-M3) sleeps for
as long as possible. Software stack support for this device is as follows:
• wM-Bus
• SimpliciTI (Star Network)

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU995E
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3.1.4 TPL5111
Features
• Selectable Time Intervals: 100 ms to 7200 s
• Timer Accuracy: 1% (typ)
• Current Consumption at 2.5 V: 35 nA (typ)
• Resistor Selectable Time Interval
• Manual Power-On input
• One-shot Feature
• Supply Voltage range: 1.8 V to 5.5 V

Applications
• Duty Cycle Control of Battery Powered

Systems
• Internet of Things (IoT)
• Intruder Detection
• Tamper Detection
• Home Automation Sensors
• Thermostats
• Consumer Electronics
• Remote Sensor
• White Goods

Figure 5. TPL5111 Functional Block Diagram

Description
The TPL5111 Nano Timer is a low power system timer, ideal for power gating in duty cycled or battery
powered applications. Consuming only 35 nA, the TPL5111 can be used to enable and disable the power
supply for a micro-controller or other system device, drastically reducing the overall system stand-by
current during the sleep time. This power saving enables the use of significantly smaller batteries and
makes the TPL5111 well suited for energy harvesting or wireless sensor applications. The TPL5111
provides selectable timing intervals from 100 ms to 7200 s. In addition, the TPL5111 has a unique One-
shot feature where the timer will only assert its enable pulse for one cycle. The TPL5111 is available in a
6-pin SOT23 package.

http://www.ti.com
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3.1.5 TPS61291
Features
• Input Voltage Range 0.9V to 5V
• Startup Voltage 1.5V at 20mA Load
• Pin Selectable Output Voltages: 3.3V, 3V,

2.5V
• 15nA typical Quiescent Current in Bypass

Mode
• 5.7μA typical Quiescent Current in Boost

Mode
• Bypass Switch from VIN to VOUT
• IOUT > 200mA at 3.3V VOUT, VIN = 1.8V
• Internal Feedback Divider Disconnect

(Bypass Mode)

• Controlled Bypass Transition Prevents
Reverse Current into Battery

• Power-Save Mode at Light Loads
• Overtemperature Protection
• Redundant Overvoltage Protection
• Small 2mm x 2mm SON 6-pin package

Applications
• Metering (Gas, Water, Smart Meters)
• Remote Controls
• Home Security / Home Automation
• Single 3V Li-MnO2 or 2 x 1.5V Alkaline Cell

Powered Applications

Figure 6. TPS61291 Functional Block Diagram

Description
The TPS61291 is a boost converter with pin selectable output voltages and an integrated bypass mode. In
bypass operation, the device provides a direct path from the input to the system and allows a low power
micro controller (MCU) such as the MSP430 to operate directly from a single 3V Li-MnO2 battery or dual
alkaline battery cells.

In bypass mode the integrated feedback divider network for boost mode operation is disconnected from
the output and the quiescent current consumption drops down to only 15nA (typical).

http://www.ti.com
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In boost mode the device provides a minimum output current of 200mA at 3.3V VOUT from 1.8V VIN. The
boost mode is used for system components which require a regulated supply voltage and cannot directly
operate from the input source. The boost converter is based on a current-mode controller using
synchronous rectification to obtain maximum efficiency and consumes typically 5.7uA from the output.
During startup of the boost converter, the VSEL pin is read out and the integrated feedback network sets
the output voltage to 2.5V, 3V or 3.3V.

Bypass mode or boost mode operation is controlled by the system via the EN/BYP pin.

The device integrates an enhanced bypass mode control to prevent charge, stored in the output capacitor
during boost mode operation, from flowing back to the input and charging the battery.

The device is packaged in a small 6-pin SON package (DRV) measuring 2.0mm × 2.0mm x 0.75mm.

http://www.ti.com
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3.1.6 TPS22860
Features
• Integrated Single Channel Load Switch
• Bias Voltage Range (VBIAS): 1.65 V to 5.5 V
• Input Voltage Range: 0 V to VBIAS

• ON-Resistance (RON)
– RON = 0.73 Ω at VIN = 5 V (VBIAS = 5 V)
– RON = 0.68 Ω at VIN = 3.3 V (VBIAS = 5 V)
– RON = 0.63 Ω at VIN = 1.8 V (VBIAS = 5 V)

• 200 mA Maximum Continuous Switch
Current

• Ultra-Low Leakage Current
– VIN Leakage Current = 2 nA
– VBIAS Leakage Current at 5.5 V = 10 nA

• 6-pin SOT-23 or SC70 Package
• ESD Performance Tested per JESD 22

– 2 kV HBM and 1 kV CDM

Applications
• Wearables
• Internet of Things
• Wireless Sensor Networks

Figure 7. TPS22860 Functional Block Diagram

Description
The TPS22860 is a small, ultra-low leakage current, single channel load switch. The device requires a
VBIAS voltage and can operate over an input voltage range of 0 V to VBIAS. It can support a maximum
continuous current of 200 mA. The switch is controlled by an on/off input (ON), which is capable of
interfacing directly with low-voltage control signals. The TPS22860 is available in two small, space-saving
6-pin SOT-23 and SC70 packages. The device is characterized for operation over the free-air temperature
range of –40°C to 85°C.

http://www.ti.com
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3.1.7 TPD1E10B06
Features
• Provides System-Level ESD Protection for

Low-Voltage I/O Interface
• IEC 61000-4-2 Level 4 ESD Protection

– ±30 kV Contact Discharge
– ±30 kV Air-Gap Discharge

• IEC 61000-4-5 Surge: 6 A (8/20 µs)
• I/O Capacitance 12 pF (Typical)
• RDYN 0.4 Ω (Typical)
• DC Breakdown Voltage ±6 V (Minimum)
• Ultralow Leakage Current 100 nA

(Maximum)
• 10-V Clamping Voltage (Max at IPP = 1 A)
• Industrial Temperature Range: –40°C to

125°C

• Space-Saving 0402 Footprint
(1 mm × 0.6 mm × 0.5 mm)

Applications
• End Equipment:

– Tablets
– Remote Controllers
– Wearables
– Set-Top Boxes
– Electronic Point of Sale (EPOS)
– ebooks

• Interfaces:
– Audio Lines
– Pushbuttons
– General-Purpose Input/Output (GPIO)

Figure 8. TPD1E10B06 Functional Block Diagram

Description
The TPD1E10B06 device is a single-channel electrostatic discharge (ESD) transient voltage suppression
(TVS) diode in a small 0402 package. This TVS protection product offers ±30-kV contact ESD, ±30-kV
IEC air-gap protection, and has an ESD clamp circuit with a back-to-back TVS diode for bipolar or
bidirectional signal support. The 12-pF line capacitance of this ESD protection diode is suitable for a wide
range of applications supporting data rates up to 400 Mbps. The 0402 package is an industry standard
and is convenient for component placement in space-saving applications.

Typical applications of this ESD protection product are circuit protection for audio lines (microphone,
earphone, and speakerphone), SD interfacing, keypad or other buttons, VBUS pin and ID pin of USB
ports, and general-purpose I/O ports. This ESD clamp is good for the protection of the end equipment like
ebooks, tablets, remote controllers, wearables, set-top boxes, and electronic point of sale equipment.
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4 System Design Theory and Considerations
The Humidity and Temperature Sensor Node for Sub-1GHz Star Networks Enabling 10+ Year Coin Cell
Battery Life TI Design measures the ambient relative humidity and temperature and achieves an extremely
long battery life through the use of duty-cycling with a nano-power system timer. The TPL5111 device
controls when the TPS61291 boost converter enters and exits its bypass mode and when the TPS22860
device disconnects the CC1310 and HDC1010 devices from the output of the boost converter. Because
the on-state is very short (the time when the CC1310 and HDC1010 have power), and the off-state current
consumption from the coin cell battery is very low, the estimated battery life is very long.

4.1 Duty-Cycled Power Design Theory
The main parameters that affect the estimated battery life of the entire system are:
• Capacity rating of the battery in milliamp-hours (mAh)
• Average off-state current consumption (nA)
• Off-state duration (s)
• Average on-state current consumption (mA)
• On-state duration (s)

The following Equation 1 describes the estimated battery life in units most convenient to this TI Design:

. (1)

Based on this equation that estimates battery life, optimizing several factors leads to a longer battery life:
• Longer TOFF

• Shorter TON

• Lower ION

• Lower IOFF

TOFF is completely controllable by the end user. In this TI Design, a value of 1 minute was chosen for the
TPL5111 wakeup interval, leading to TOFF of the following form in Equation 2:

(2)

Equation 2 indicates that the system wakes up once every minute to measure the ambient relative
humidity and temperature and transmit an RF packet with that data.

TON is somewhat less controllable because there is a minimum amount of time required to power up the
system, take the measurement from the HDC1010 device, transmit the packet, and shut down again. The
HDC1010 device has a specified TWAIT period after power up before anything can be done, along with a
TCONV, which is the time it takes to convert the humidity and temperature measurements. The I2C
transactions between the CC1310 and HDC1010 devices require time to successfully complete, as well as
transmitting the data packet from the CC1310 device.

IOFF is defined as the average current consumed from the battery during the off-state. This current is
comprised primarily of the leakage through the TPS22860 load switch, the operating current of the
TPL5111 nano-power system timer, and the current required to re-charge the bulk capacitor that is placed
near the CR2032 coin cell battery, as well as the steady-state leakage current through that same bulk
capacitor.

Section 6.2 has more details about the battery life performance of this TI Design.

http://www.ti.com
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4.2 Wireless Network Design Theory
Because the power is completely cut off from the CC1310 wireless MCU, the use of this TI Design is
intended for a star network configuration. This configuration means that each sensor end-node connects
directly to a central receiver, which receives the data from each end-node and then performs any
necessary processing and connection to the cloud. This configuration implies that this TI Design is not
intended for use in smart mesh networks, because the wireless microcontroller does not retain its state or
have any control over when it wakes up.

The TI Design as released sends out non-connectable data packets that contain four bytes of data: two
bytes of temperature data and two bytes of relative humidity data. This data is transmitted directly as the
HDC1010 device outputs it; no post-processing or correction is implemented on the CC1310 device itself.
However, if the sensor data requires any pre-processing, the CC1310 device is more than capable of
completing any processing task in a short time with the powerful ARM® Cortex® -M3 processor.

The antenna on this TI Design is the miniature helical PCB antenna for 868 MHz or 915MHz. See the
application note DN038 (SWRA416) for more details about layout and performance.

4.3 Firmware Control
The firmware for this TI Design is built on TI-RTOS and has been modified to send out non-connectable
data packets. These packets contain four bytes of data directly from the HDC1010 device. I2C drivers
have also been added to the firmware to enable communication with the HDC1010 device.

After the packet with the HDC1010 data has been sent, the CC1310 device is programmed to pull a
general-purpose input or output (GPIO) pin high; this GPIO is connected to the DONE pin of the TPL5111
device. When the TPL5111 device receives a high level on the DONE pin, the TPS61291 boost converter
is signaled to enter bypass mode and the TPS22860 device is signaled to open the connection between
the boost converter output and the rest of the circuit.

During periods where the CC1310 device is required to wait, which is primarily for the HDC1010 device to
start up and to complete humidity and temperature conversions, a one-shot timer is used. This method of
waiting enables the CPU of the CC1310 device to shut down, which lowers the average on-state current
significantly.

http://www.ti.com
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5 Getting Started

5.1 Hardware Overview
Figure 9 shows the hardware for the Humidity and Temperature Sensor Node for Sub-1GHz Star
Networks Enabling 10+ Year Coin Cell Battery Life TI Design. The printed circuit board (PCB) is in a
1.5- × 3.0-inch rectangular form factor and comes with 0.5-inch nylon standoffs to ensure ease of use
while performing lab measurements.

Figure 9. Humidity and Temperature Sensor Node for Sub-1GHz Star Networks Enabling 10+ Year Coin
Cell Battery Life Reference Design Hardware

All of the integrated circuits (CC1310, TPL5111, TPS22860, and HDC1010), several test points and
jumpers, as well as the ESD protection devices for the programming header are located on the top side of
the PCB. The 2.4-GHz antenna is also located on the top side of the PCB.

The bottom side of the PCB contains the CR2032 coin cell battery holder.

There are four unused GPIOs that have been brought out from the CC1310 device to an unpopulated
header to facilitate future prototyping and debugging.

5.2 Loading Firmware
The firmware used on this TI Design was developed using TI’s Code Composer Studio™ software
(version 6.1.0).

The IAR Embedded Workbench for ARM () also supports the CC13xx line of SimpleLink™ products.

To program or debug the TI Design hardware, closing J2 with a jumper shunt is necessary; this bypasses
the TPS22860 load switch. If J2 is left open, then the TPL5111 device continues to control the power of
the CC1310 device, preventing proper programming and debugging.

Powering the board from 3.0 V is also necessary and is supplied at the test point labeled VBATT.
Connecting the external power source at this location bypasses the Schottky diode.

NOTE: For programming the TI Design hardware, it is necessary to shunt J2 and provide 3.0 V at
the VBATT test point.

http://www.ti.com
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The TI Design hardware is programmed by connecting the 10-pin mini ribbon cable from J5 to the
SmartRF06 Evaluation Board (10-pin ARM Cortex Debug Connector, P418). See Figure 10 for a photo of
the correct setup for connecting the TI Designs hardware to the SmartRF06 evaluation board.

Figure 10. Connection of SmartRF06 Evaluation Board and TI Designs Hardware for
Programming and Debugging

http://www.ti.com
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5.3 Receiving Data Packets Using CC1111 USB Dongle and SmartRF Protocol Packet Sniffer
As this reference guide previously describes, this TI Design is programmed to read the relative humidity
and temperature data from the HDC1010 device and then broadcast that data as a non-connectable data
packet. The data payload consists of two bytes of temperature data, followed by two bytes of relative
humidity data.

To verify the proper operation of the radio transmission, the CC1111 USB Dongle CC1111 USB EVM Kit
868/915 MHz is used to “sniff” packets using the SmartRF™ Protocol Packet Sniffer software. After
installing the packet sniffer software (v2.18.1 at the time of writing), the procedure is as follows to detect
the data transmissions:
1. Plug the CC1111 USB dongle into an unused USB port on the computer with the packet sniffer

software installed.
2. Open the packet sniffer software; choose Generic as the protocol and click the Start button.

Figure 11. SmartRF™ Protocol Packet Sniffer Software Interface

3. CC1111 must be configured correctly to see the packets. Select the Radio Configuration tab. Under
the Register settings sub tab, click on the “Browse…” button. Open the TIDA-00484_CC1111.prs file.
Highlight and double-click on “TIDA-00484_CC1111” to apply the register settings (see Figure 12).

NOTE: If long data acquisition periods are expected, please increase the Cache Buffer size in the
packet sniffer software to prevent possible crashes. Take this action by opening the Settings
menu and clicking "Cache buffer size...".

4. Press the Play button on the top toolbar to initiate the packet capture process.
5. The packet sniffer software is likely to detect many other packets. To view only the valid data packets,

to the user must apply a display filter. The following screen capture from Figure 12 shows a sample
display of what records without a filter applied. The highlighted row shows an undesired data packet.

http://www.ti.com
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Figure 12. Sample Display—No Filter Applied

6. The appropriate filter checks for only valid packets. In the Field Name field, select “FCS” from the drop-
down options. Click the button labeled First. Modify the filter condition to only show “OK” packets by
typing “FCS=OK” in the Filter condition field , click the Add button, and then click the Apply filter button.
The following screen capture in Figure 13 shows an example filtered view.

http://www.ti.com
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Figure 13. Sample Display—With Filter Applied

7. To export the captured, filtered packets, click the ”Save the current session” button on the toolbar
(appears as a floppy disk), or pause the packet capture and click File→ Save data… from the file
context menu; either of these choices prompts to save the displayed data as a packet sniffer data
(.psd) file.

8. HexEdit software (http://www.hexedit.com/) is used to convert the .psd file to readable hex values. A
different hex editor may perform this function as well; however, the authors of this document have not
verified any other options.

9. Open the .psd file in the HexEdit software. Click on Tools→ Options. In the HexEdit Options window,
click on Document→ Display and change the Columns value to “2066”. Click Edit→ Select All and
Edit→ Copy As Hex Text. Open a text editor program (for example, Notepad), paste the hex text, and
save the text file. This text file can then be imported into Microsoft Excel® spreadsheet software for
further analysis. For more information on the sniffer data packet format, click Help→ User Manual on
the packet sniffer software.

http://www.ti.com
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6 Test Data

NOTE: The test data in the following sections was measured with the system at room temperature,
unless otherwise noted.

All of the measurements in this section were measured with calibrated lab equipment.

6.1 Overview
The Humidity and Temperature Sensor Node for Sub-1GHz Star Networks Enabling 10+ Year Coin Cell
Battery Life TI Design has been characterized for functional usage including power consumption, relative
humidity performance, temperature performance, and radio transmission range.

The following subsections show the results of testing and characterization. Any plots of the HDC1010
device’s output data was produced using data packets captured using a CC1111 USB Dongle EVM kit
and SmartRF Protocol Packet Sniffer software, as Section 5.3 describes in further detail, with data
formatting and analysis performed using Microsoft Excel.

6.2 Power Consumption
Because the primary purpose of this TI Design is to showcase a power topology for battery-powered
wireless sensor end-nodes, characterization of the system’s power consumption is critical.

As Section 4.1 describes, there are two states that this TI Design system is in: on-state and off-state. Both
the duration and the average current of each state are factors in estimating the total battery life of the TI
Design system.

The on-state consists of the TPL5111 device’s timer interval expiring, resulting in the TPS61291 boost
converter regulating its output to 3.3 V and the TPS22860 load switch connecting the boost output voltage
to the rest of the system. The CC1310 device receives power, communicates with the HDC1010 device
using I2C, receives the current temperature and relative humidity information, transmits a non-connectable
data packet with that data, and then signals the TPL5111 device that the system can be shut back down.

The off-state consists of completely disconnecting the rest of the system (CC1310 and HDC1010 devices)
from the coin cell battery by means of the TPS22860 load switch. The sources of off-state current
consumption from the coin cell battery are the recharging and leakage currents due to the bulk capacitor
near the coin cell, the operating current of the TPL5111 nano-power system timer device, the quiescent
current of the TPS61291 boost in bypass mode, and the leakage current due to the TPS22860 load
switch.

http://www.ti.com
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6.2.1 On-State Power Characterization
The on-state duration and average current was characterized with the use of a Tektronix MDO3024 Mixed
Domain oscilloscope and a Tektronix TCP0030A current probe. The oscilloscope was connected directly
to a laptop through a USB cable and uses the corresponding software to directly export the recorded data
points. Figure 14 shows the current drawn from the coin cell battery, as measured through jumper J1.

Figure 14. On-State Current Versus Time

At time t = 0 ms, the TPL5111 device activates and immediately the current jumps up to about 42 mA. The
current draw then quickly settles to less than 1 mA before spiking again at time t = 25 ms, before decaying
to less than 1 mA again.

The first current spike at turn on is due to the output capacitor being charged from VBATT up to 3.3 V
after the TPS61291 boost converter transitions from bypass mode to normal switching operation. The
second current spike is due to the CC1310 device transmitting a sub-1 GHz radio packet.

The on-state is considered complete at 30 ms when the current level drops below the accuracy of the
current probe in use, and the V_SWITCH voltage net stops decreasing, which indicates that the CC1310
wireless MCU has fully shut down.

By exporting the data into Microsoft Excel for analysis, the design team was able to determine that the
average current over the first 30 ms of system operation was 3.376 mA. This current is considered the
average on-state current of the TI Design system.
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http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU995E


Time (s)

I  B
at

t (
nA

)

0.02 0.1 1 10 100
20

100

1000

10000

100000

D002

Region 1 Region 2

www.ti.com Test Data

25TIDU995E–June 2015–Revised September 2018
Submit Documentation Feedback

Copyright © 2015–2018, Texas Instruments Incorporated

Humidity and Temperature Sensor Node for Sub-1GHz Star Networks
Enabling 10+ Year Coin Cell Battery Life

6.2.2 Off-State Power Characterization
The off-state duration and average current was characterized with the use of a Keysight (formerly Agilent)
34401A digital multimeter (DMM) with 6½ digits of resolution. The DMM was connected directly to a laptop
with the corresponding software to directly export the recorded data points. Figure 15 shows the current
drawn from the coin cell battery, as measured through jumper J1.

Figure 15. Off-State Current Versus Time

The data has been plotted logarithmically on both the x- and y-axes because the first portion of the plot,
labelled “Region 1”, has a much higher current and shorter time duration than that of “Region 2”.

“Region 1” is actually the portion of the off-state where the bulk capacitor continuously recharges directly
from the coin cell. The first data point occurs at approximately 25 ms after the system first powers up and
then is essentially complete after ten seconds. The average current over Region 1 is 1.4325 μA.

The off-state current during Region 2 is dominated by the operating current of the TPL5111 device (35 nA
typical), and the quiescent current of the TPS61291 boost converter in bypass mode (15 nA). The supply
current in this TI Design system is nominally 3.0 V; in practice, the supply current can be somewhat higher
(3.2 V to 3.3 V) depending on the age of the coin cell in use. As Section 6.2 previously mentions, the
leakage current of the bulk capacitor (approximately 8.33 nA), the TPS61291 boost converter in bypass
mode (15 nA), and the TPS22860 load switch (±20 nA) also contribute to the off-state current during
Region 2. Given the expected values of the sources of off-state current, the measured average value of
48.70 nA during Region 2 is quite reasonable.

The off-state current is equal to 269.75 nA, which is averaged over the entire duration of Regions 1 and 2
and lasts for a duration of 1 minute – 30 ms = 59.970 seconds.
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http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU995E


( )
6

240 mAh 1 year
Battery life 85% 11.9 Years

8760 hours3.376 mA 0.030 s 269.75 nA 59.970 s 10

0.030 s 59.970 s

-
= ´ ´ =

æ ö´ + ´ ´
ç ÷ç ÷+è ø

Test Data www.ti.com

26 TIDU995E–June 2015–Revised September 2018
Submit Documentation Feedback

Copyright © 2015–2018, Texas Instruments Incorporated

Humidity and Temperature Sensor Node for Sub-1GHz Star Networks
Enabling 10+ Year Coin Cell Battery Life

6.2.3 Estimated Battery Life Calculations
As Section 4.1 shows, the equation used for estimating battery life of the TI Design system has five
parameters:
• Capacity rating of the battery in milliamp-hours (mAh)
• Average off-state current consumption (nA)
• Off-state duration (s)
• Average on-state current consumption (mA)
• On-state duration (s)

As previously stated, the battery used in this TI Design is a CR2032 lithium-ion coin cell that has a
capacity rating of 240 mAh. The battery life equation has a built-in de-rating factor of 85%, which attempts
to model the effects of varying temperatures, as well as battery self-leakage.

When using the measured values for the remaining parameters, Equation 3 shows the following battery
life calculation:

(3)

Because the estimated battery life for this TI Design system is above the specified shelf life of typical coin
cell batteries, it is possible to increase the transmit power of the CC1310 device to increase range.
Alternatively, more processing of the sensor data can be done on the sensor end-node to decrease the
burden on the up-stream data processing units.

6.2.4 Duty-Cycled System Tradeoffs
This TI Design is based around the concept that by duty-cycling the system with a nano-power system
timer, the off-state current can be lowered beyond that of what any inherent sleep mode of the remaining
components can achieve. A comparison between a system using this duty-cycling concept and one that
does not use this concept can be valuable, because there are various situations where either system
topology could make sense.

With the assumption that the on-state current and duration remain fixed for both types of system
topologies, comparing the two is possible. By varying the wakeup interval, certain scenarios exist where
using the built-in standby mode of the CC1310 device makes more sense, rather than using the TPL5111
device. The assumption is that by using the built-in standby mode of the CC1310 device, the off-state
current goes from 269.75 nA up to approximately 2 μA. Also, a reference line is displayed with a level of
ten years, a common shelf life of coin cell batteries.
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However, as Figure 16 shows, the system using the TPL5111 device to duty-cycle the system always has
a better estimated battery life, particularly at longer system wakeup intervals. The only scenario where the
use of a TPL5111 device to create a duty-cycled sensor end-node is not practical is if the wireless network
is a sleeping mesh network. In the case of a sleeping mesh network, the CC1310 device must be in
control of its own sleep state to maintain network communications. Furthermore, utilizing additional load
switches to the system is a likely requirement to ensure that quiescent or standby currents of any other
sensors or devices in the system are minimized during the off-state. Adding additional load switches can
potentially increase the system cost and complexity.

Figure 16. Estimated Battery Life Comparison: TPL5111 Nano-Power System Timer Versus CC1310
Standby Mode

If the end-equipment system has different requirements for the on-state current and duration, this
calculation can vary significantly. Re-run these calculations to determine what sort of system topology
makes the most sense to achieve the longest battery life possible.
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6.3 Relative Humidity Characterization
This TI Design exemplifies the concept of a duty-cycled sensor end-node through the use of the HDC1000
device, which measures both relative humidity and temperature.

To better understand how the TI Design system responds to varying relative humidity levels, the hardware
was placed in a Thunder Scientific® Model 2500 Benchtop Humidity Generator
(http://www.thunderscientific.com/) with a new Energizer® brand CR2032 lithium-ion coin cell battery. The
CC1111 USB Dongle EVM Kit was plugged into a USB extension cord and placed next to the TI Design
hardware for optimal data packet reception performance. A Rotronic© HC2-S precision humidity and
temperature probe (http://www.rotronic.com) and Rotronic Hygro Flex HF53 transmitter was used to
provide reference relative humidity and temperature measurements. Figure 17 shows the test setup.

Figure 17. Relative Humidity Test Setup

The relative humidity was then programmed to run a pre-defined profile. This profile set the initial chamber
humidity to 20% and soaked the TI Design hardware for an initial 40 minutes. The relative humidity was
then ramped up to 30% at a controlled rate over 10 minutes and then soaked at that humidity level for 20
minutes. This process was repeated up to the maximum tested relative humidity of 70%, then decreased
similarly to the minimum humidity level of 20%, and finally soaked for 40 minutes to end the test. The
temperature during this profile was held to a set-point of 45°C.

The HDC1000 output data was recorded using the CC1111 USB dongle and packet sniffer software
combination that Section 5.3 describes.
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Figure 18 shows the measured relative humidity from the HDC1000 device over the duration of the test as
well as the reference relative humidity from the Rotronic HC2-S precision humidity and temperature probe.
These results show the HDC1000 device tracks the reference relative humidity very closely.

Figure 18. HDC1000 Measured Relative Humidity Data

NOTE: The HDC1000 was used for the Relative Humidity testing. The HDC1010 has the same
functionality and pinout as the HDC1000 but is not an exact equivalent.

Testing using the HDC1010 will be done at a later date.
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6.4 Temperature Characterization
This TI Design exemplifies the concept of a duty-cycled sensor end-node through the use of the HDC1000
device, which measures both relative humidity and temperature.

To better understand how the TI Design system responds to varying temperatures, the hardware was
placed in a TestEquity 1007H Temperature/Humidity Chamber (http://www.testequity.com/products/1104/)
with a new Energizer CR2032 lithium-ion coin cell battery. Two test wires were routed outside the
chamber to a Keysight (formerly Agilent) 34401A DMM with 6½ digits of resolution for monitoring of the
V_BATT voltage net. The CC1111 USB Dongle CC2540 USB EVM Kit was plugged into a USB port near
the TI Design hardware for optimal data packet reception performance. Figure 19 shows the test setup.

Figure 19. Temperature Test Setup

The temperature was then programmed to run a pre-defined profile. This profile set the initial chamber
temperature to 25°C and soaked the TI Design hardware for 10 minutes. The temperature then ramped up
to 35°C at a controlled rate over five minutes and then soaked at that temperature for 10 minutes. This
process was repeated up to the maximum temperature of 60°C and then decreased similarly to the
minimum temperature of −30°C. Finally, the temperature was increased back to 25°C using the same
controlled method. Relative humidity was allowed to vary during the temperature test to best emulate the
response of a real-world environment.

The HDC1000 output data was recorded using the CC1111 USB dongle and packet sniffer software
combination that Section 5.3 describes.
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Figure 20 shows the environmental chamber set-point and the measured temperature from the HDC1000
device over the duration of the test. As is clearly visible, the HDC1000 device tracks the chamber
temperature very closely.

Figure 20. HDC1000 Measured Temperature Data and Environmental Chamber Set-Point

Due to the nature of CR2032 lithium-ion coin cell battery chemistry, the output voltage can drop slightly
(tens to hundreds of millivolts) at lower temperatures. However, if all components in the system work
throughout the lifetime operating voltage of the coin cell, this output voltage drop should not be an issue
for proper operation.

NOTE: The HDC1000 was used for the Relative Humidity testing. The HDC1010 has the same
functionality and pinout as the HDC1000 but is not an exact equivalent.

Testing using the HDC1010 will be done at a later date.
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7 Design Files

7.1 Schematics
To download the schematics, see the design files at TIDA-00484 Schematics.

7.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDA-00484 BOM.

7.3 Layer Plots
To download the layer plots, see the design files at TIDA-00484 Layer Plots.

7.4 Altium Project
To download the Altium project files, see the design files at TIDA-00484 Altium.

7.5 Layout Guidelines
To ensure high performance, the Humidity and Temperature Sensor Node for Sub-1GHz Star Networks
Enabling 10+ Year Coin Cell Battery Life TI Design was laid out using a four-layer PCB. The second layer
is a solid GND pour, and the third layer is used for power rail routing with GND fills in unused areas. The
top and bottom layers are used for general signal routing and also have GND fills in unused areas. For all
of the TI products used in this TI Design, ensure that care is taken to adhere to the layout guidelines
detailed in the respective datasheets.

7.6 Gerber Files
To download the Gerber files, see the design files at TIDA-00484 Gerber.

7.7 Assembly Drawings
To download the assembly drawing files, see the design files at TIDA-00484 Assembly Drawing.

7.8 Software Files
To download the software files, see the design files at TIDA-00484.
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